MASTER OF SCIENCE
IN RADIOLOGIC SCIENCES
Department of Radiologic Sciences

CONTENT AND STYLE REQUIREMENTS
FOR PAPERS AND THESIS REPORT
CONTENT AND STYLE REQUIREMENTS
FOR PAPERS AND THESIS REPORT

by

Master of Science in Radiologic Sciences

A publication produced to help candidates complete the degree of

MASTER OF SCIENCE
IN RADIOLOGIC SCIENCES

WEBER STATE UNIVERSITY
Ogden, Utah

Last Updated: May 2013
Acknowledgements

The acknowledgements section is generally used to recognize professors, teachers, friends, and/or family who have supported the successful completion of the thesis report and time in the Master of Science in Radiologic Sciences program. It is optional – not required – and should not be more than one page. The Acknowledgements heading should be a Level 1: Centered, Boldface, Upper and Lowercase
# Table of Contents

REQUIREMENTS FOR PRODUCING A PAPER OR REPORT ........................................ 10

- Formatting Course Papers and Thesis Report ........................................... 10

Formatting ....................................................................................................... 10

- Typeface ...................................................................................................... 10
- Spacing ....................................................................................................... 10
- Automatic tabs ........................................................................................... 10
- Running head ............................................................................................. 10
- Page numbering .......................................................................................... 11
- Justification and margins ........................................................................... 11

Language ......................................................................................................... 11

- Anthropomorphism ..................................................................................... 12
- Tense .......................................................................................................... 12
- Declarative language ................................................................................... 12
- Noun/Pronoun agreement .......................................................................... 12
- Second person pronouns .......................................................................... 13

Table of Contents ........................................................................................... 13

List of Tables .................................................................................................. 13

List of Figures ................................................................................................ 14

Headings ......................................................................................................... 14

Quotations ....................................................................................................... 15

Tables ............................................................................................................. 16

- Wide Tables ............................................................................................... 18
- Long Tables ................................................................................................. 19

DIVISIONS OF THE THESIS PROPOSAL ....................................................... 20
DIVISIONS OF THE FINAL THESIS REPORT ......................................................... 24

Title Page ........................................................................................................... 24
Copyright Notice ................................................................................................. 24
Dedication or Acknowledgements ..................................................................... 24
Table of Contents ................................................................................................. 25
List of Tables ....................................................................................................... 25
List of Figures ...................................................................................................... 25
Abstract ............................................................................................................... 27
Body of the Thesis ............................................................................................... 27
  Nature of the Problem ....................................................................................... 27
  Purpose .............................................................................................................. 28
  Method .............................................................................................................. 28
  Results .............................................................................................................. 28
  Discussion ........................................................................................................ 29
Appendices........................................................................................................... 30

REFERENCES........................................................................................................ 31

APPENDICES........................................................................................................ 32

Appendix A: Sample of Proposal Title Page ...................................................... 33

Appendix B: Sample of Thesis Report Title Page ............................................. 35
List of Tables

Table 1. *Levels of Headings* ............................................................................................................................ 11
List of Figures

Figure 1. Project proposal pyramid ................................................................. 16
Abstract

Write a summary highlighting the key points of the thesis report (do not indent the first line). The Abstract heading should be a Level 1: Centered, boldface, upper and lowercase. The abstract should be between 150 and 250 words, including the topic of the research, research questions, method, results, and conclusions. The abstract should be a single paragraph, double-spaced. Also, include a minimum of three keywords at the bottom of the abstract that will assist future researchers in finding the thesis report in databases, such as Weber State University’s Stewart Library. Starting on a new paragraph, indent and italicize Keywords: and then list the keywords.

Keywords: style guide, thesis, radiologic sciences
REQUIREMENTS FOR PRODUCING A PAPER OR REPORT

The Master of Science in Radiologic Sciences program follows the *APA Publication Manual*, 6th Edition. The following items cover any exceptions and the basic format that should be followed for any papers and thesis report produced. Also, note that this publication has been developed as an example to how program papers and thesis report should look using Microsoft Word 2003-2007 or 2010. If questions are not addressed in this publication, please refer to an *APA Publication Manual*, 6th Edition, and/or the committee chairperson.

Formatting Course Papers and Thesis Report

**Formatting**

**Typeface.** The typeface of all papers and reports should be Times New Roman, 12-point font. The default font in some programs is a sans serif font, such as Calibri. The typeface font needs to be changed for the entire document, including the header.

**Spacing.** Some word processing software, by default, add an extra space after a paragraph. Use the styles dialogue box in Microsoft Word to select “No Spacing.” All other text should be double-spaced, including block quotations, tables, and references.

**Automatic tabs.** Paragraphs should be indented 0.5” using the tab key, *not* the space bar. Be sure to move the tab over for headings. The heading should be centered between margins, not between the left tab and right margin.

**Running Head.** To make a proper running head, insert a header that allows for the running head to be flush left, in all capitals. This formatting can be accomplished using the *Header* tab and selecting the left position in the drop down menu. Be sure to then change to the correct font – Times New Roman.
**Page numbering.** All pages should be numbered beginning with the title page and should be in the same typeface of the paper. All preliminary pages (Table of Contents, Lists of Tables and Figures, and Abstract) should use roman numerals and be centered at the bottom of the page. Page numbers for the body of the report and appendices should be located at the top of the page, flushed right. Tab to the far right on the same line as the Header, click on the *Page Number* tab and a drop down menu will appear. A condensed title of the report should also be included and flushed left on the page.

Do NOT include the running head on the title page for papers and the thesis report. Suppress the running head by using the design tab under the *Header & Footer Tools*. Click on *Different First Page*, and it will automatically delete the information on the title page, leaving the second page numbered correctly with the running head.

**Justification and margins.** The entire paper should be *left* justified. All margins should be set at one inch (1”).

**Language**

The thesis report should be written in a third-person voice. While writing, remember to use language that meets the standards of today’s usage. Avoid sexist, racist, and other discriminatory language that will likely distract readers. Furthermore, avoid value-laden words and phrases which could distract readers. Maintain objectivity throughout the text. The only exceptions to the rule are the *Summary* and *Conclusion* sections of the thesis report. These sections expect the results to be interpreted, and implications are to be discussed.

Also, avoid jargon and slang. Write as if addressing non-technicians who are not familiar with certain technical words, phrases, or acronyms. If such words and phrases are avoidable, a
Definition of Terms appendix should be included at the end of the report. Also, such a section may be critical if establishing a common ground for certain terms and words.

**Anthropomorphism.** This problem appears in writing when human characteristics are given to inanimate objects or animals. An example: The school decided to have recess at 10 a.m. In the example “the school” cannot “decide.” The correct way to write the sentence: The teachers at the school decided to have recess at 10 a.m.

**Tense.** Maintaining proper verb tense throughout the paper helps the reader. In the proposal and final thesis report, the Literature Review section should be written in past, active-voice tense. It is best to avoid helping verbs such as had, have, has, was, and were. For the proposal, the Purpose and Method sections are written in future tense. When preparing for the final report, those two sections are rewritten to reflect past tense.

**Declarative language.** Although APA writing style allows for sentences or paragraphs to begin by referencing the author [i.e., Smith and Jones (2010) stated that educated women are more likely to…], writing this way tends to make the sentences choppy and the actual research that the authors did becomes less of the focal point. The best way is to begin with the actual findings of the research finishing with the citation in parentheses at the end of the statement [i.e., Educated women are more likely to…(Smith & Jones, 2010)].

**Noun/Pronoun agreement.** Because the English language uses gender specific single pronouns (he/she, his/her) and APA writing style requires gender neutrality whenever possible, it is suggested that using the plural form of nouns helps the noun/pronoun agreement dilemma. Instead of saying, “The teacher should be aware of students in their classroom,” which is incorrect; rewrite the sentence to read, “Teachers should be aware of students in the classrooms.”
**Second person pronouns.** Always avoid using the pronouns you and your when writing academic and scholarly papers. Many times these words can be avoided by substituting a noun.

**Table of Contents**

The Table of Contents contains all major headings in the report. Sub-levels may be used and should be consistent throughout the Table of Contents. Generally, all preliminary pages (Acknowledgments, Abstract, etc.) are not listed in the Table of Contents, although they are numbered according to the information above. Be sure the headings and subheadings are capitalized as they appear in the text with each subheading tabbed 0.5”, as shown in the example. Note that no bold is used within the Table of Contents.

Set the decimal tab stop so that page numbers will be flush right and that periods will follow the headings or subheadings to the page numbers. This can be done in Microsoft Word by the following process:

1. On the **Home** tab, in the **Paragraph** menu (you may need to select the small arrow icon, right of the word ‘Paragraph’), click **Tabs**.
2. Under **Tab stop position**, type 6.5”, select a lead character (in this case, the dotted line).
3. Under **Alignment**, select the right alignment for text typed at the tab stop.
4. Under **Leader**, click the leader option you want, and then click **Set**.

**List of Tables**

Type the table titles exactly as they appear in the text. Titles and page numbers must be the same size and font as the text. The appropriate formatting of text is to place a period after the table number (Table X.) and to italicize the title of your table. Use decimal tab stops as described in the Table of Contents.
List of Figures

Type the captions of the figures exactly as they appear in the text. Titles and page numbers must be the same size and font as the text. The appropriate formatting of text is to italicize the figure number and place a period after the figure number (*Figure X.*). Unlike the List of Tables, do not italicize the title of the figure. Use decimal tab stops as described in the Table of Contents section.

Headings

Main section headings (Nature of the Problem, Purpose, Method, Results, Discussion, References, and Appendices) or chapters begin on a new page and should be centered, all caps, and bold. This heading level is not described in the *APA Publication Manual*. For clarity and use for the thesis report, it will be called a Level 0 heading. Use a page break to place the heading at the top of the page. This action is accomplished in two ways: Insert a page break in the *Page Layout* tab by selecting *Breaks* in the *Page Setup* box, or by pressing `<CTRL>` Enter with the cursor in front of the heading. Table 1 shows the various levels of headings to be used in the thesis report.

Table 1

*Levels of Headings*

<table>
<thead>
<tr>
<th>Level</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CENTERED, BOLDFACE, UPPERCASE</td>
</tr>
<tr>
<td>1</td>
<td>Centered, Boldface, Upper and Lowercase Headings</td>
</tr>
<tr>
<td>2</td>
<td>Left-aligned, Boldface, Upper and Lowercase Heading</td>
</tr>
</tbody>
</table>
Indented, boldface, lowercase heading with a period. Begin body of text after the period.

Indented, boldface, italicized, lowercase heading with a period. Begin body of text after the period.

Indented, italicized, lowercase heading with a period. Begin body of text after the period.

Quotations

Always give credit when using another’s words. If unsure, give the credit due to the original author. The practice of plagiarism uses and passes off someone else’s ideas, inventions, writings, etc., as one’s own; plagiarism may subject students to expulsion from the Master of Science in Radiologic Science program at Weber State University.

Any material used verbatim from another source, and is not or cannot be paraphrased, must be set apart by double quotation marks within the text using correct citation. For example, “If this were a quote, note the beginning quotation mark and the ending quotation mark, and how it is cited” (source, year, page number). When citing a source within the text at the end of a sentence, cite the source in parentheses immediately after the closing quotation marks with the punctuation outside the final parentheses.

If quotations are 40 or more words, then it needs to be block-quoted, starting on a new line, indented from the left margin, and double-spaced. For example, if quoting a source (year):

Then the quote would look like this. No quotation marks are necessary as it is recognized as a quote (double quotations can be used inside a quote, if needed). At the end of the quote, the page number is entered inside parentheses as follows. (Page number)
To cite a source at the end of a block quote, cite the source in parentheses after the final punctuation mark.

Tables

The formatting of tables should appear standard and not provide color and/or borders; only limited borders are used in the creation of tables. Additionally, allow ample white space between the body of text and a table, as to differentiate where one ends and the other begins. Tables should try to be on one page (refer to Long Tables if your table is larger than the amount of space given). The following process will walk you through the creation of your table(s):

1. Enter the word “Table” with the table number. Note that there is no period after the number.
2. Double space and enter your table title in italics. Capitalize all major words – all nouns, verbs, adjectives, adverbs, and pronouns. If a term is hyphenated, capitalize both words in the term.

Here is what you should have so far:

Table 1

Response Rates of the Effectiveness of the Master of Science in Radiologic Sciences Program

3. Create your table, by selecting the Insert tab, and selecting the Tables pull-down menu.
4. Select your table and turn off all borders by selecting the borders icon found under the Home or Layout tabs.
5. Insert a heading for each column of data. Keep all headings short and meaningful. If the heading is too long and cannot be shortened, insert a hard return where you want the text to break – the heading should not be much wider than the data in the column.

6. Use standard abbreviations where appropriate (‘n’ instead of number, ‘%’ in place of percent, etc.). Nonstandard abbreviations and acronyms may need to be explained in the table notes. Center all headings, with the exception of the left-hand column.

7. Under the various header rows, select a bottom border from the border icon

Here is what you have so far (dotted lines added to show cell boundaries):

Table 1

Response Rates of the Effectiveness of the Master of Science in Radiologic Sciences Program

<table>
<thead>
<tr>
<th>Statements</th>
<th>Strongly agree</th>
<th>Agree</th>
<th>Undecided</th>
<th>Disagree</th>
<th>Strongly disagree</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
</tr>
</tbody>
</table>

8. Insert text in the left-hand column. In quantitative studies, the left-hand column generally consists of a list of the major dependent variables.

Table 1

Response Rates of the Effectiveness of the Master of Science in Radiologic Sciences Program

<table>
<thead>
<tr>
<th>Statements</th>
<th>Strongly agree</th>
<th>Agree</th>
<th>Undecided</th>
<th>Disagree</th>
<th>Strongly disagree</th>
</tr>
</thead>
<tbody>
<tr>
<td>The learned about administration</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
</tr>
<tr>
<td>I learned about various modalities</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
<td>n %</td>
</tr>
</tbody>
</table>
9. Insert the text for the remaining data columns. Format numerical data as follows:

   Horizontally align right; have equal decimal places for all numbers in a column; Add an asterisk to indicate values for which the null hypothesis was rejected; and enter a dash in any cell with missing data and explain in a general note. If data is not applicable for a cell, leave the cell blank.

10. After all information has been input, add a top border to the first row and a bottom border to the bottom row.

Table 1

Response Rates of the Effectiveness of the Master of Science in Radiologic Sciences Program

<table>
<thead>
<tr>
<th>Statements</th>
<th>Strongly agree</th>
<th>Agree</th>
<th>Undecided</th>
<th>Disagree</th>
<th>Strongly disagree</th>
</tr>
</thead>
<tbody>
<tr>
<td>The learned about administration</td>
<td>15   68.2</td>
<td>6  27.3</td>
<td></td>
<td>1  4.5</td>
<td></td>
</tr>
<tr>
<td>I learned about various modalities</td>
<td>12   54.5</td>
<td>1  4.5</td>
<td>2  9.1</td>
<td>1  4.5</td>
<td></td>
</tr>
</tbody>
</table>

Note. If notes are needed to describe information in your table, provide below your table. The notes should continue to be double-spaced and be a 10-point font. The beginning of your note should have the word ‘Note’ followed by a period and italicized.

Wide Tables. If your table needs more space than the 6 inches allowed in a standard page, format it in landscape view.

1. As soon as possible after the table is mentioned, while being careful not to leave too much white space at the end of a page, enter a section break. In Microsoft Word, they are found under the Page Layout tab in the Page Setup section. Select the Next Page option.
2. Under Page Layout, change your margins so that you have a 1.5-inch top margin and a 1-inch margin on the sides and bottom. Be careful to select **Apply to this section** before you click **OK**.

3. Create your table.

4. At the end of the table, enter another section break.

5. Open the footer in the section that you just created—the section after the section with the table.

6. Deselect **Link to Previous**.

7. Go back to the section containing the table and delete the page number. Full-page tables and figures are not to have page numbers.

**Long Tables.** If your table is too long to fit on one page, you must break it and continue it on another page. It is better not to break a table if at all possible. Try inserting another paragraph of text to force the entire table to the next page. However, never split a paragraph to insert a table. If you must split a table, follow these formatting guidelines:

1. Never break the table after the heading or in the middle of a row.

2. Add a bottom border to the last row on the first page.

3. Below the bottom border, flush right, insert the following: *Table 1 continues*

4. At the top of the next page, flush left, insert the following: *Table 1 continued*

5. Repeat the header row(s) below *Table 1 continued*. Ensure that the header row has a top and bottom border just as it did on the previous page.
DIVISIONS OF THE THESIS PROPOSAL

The following will provide a summary of the major divisions of the master’s thesis report. Depending on the nature of the report, there may be minor variations, which are acceptable; consult with the committee chairperson.

The divisions of the master’s thesis report proposal are arranged in the following order: Title Page, Nature of the Problem, Purpose, Method, and References.

Title Page

The title page of the proposal contains the title of the manuscript, the full name of the student/author, the affiliation (Weber State University), and the date. Do NOT use boldface font (see Appendix A as an example). All major headings beyond the title page begin on a new page and use uppercase letters (Table 1).

Body of the Proposal

Nature of the Problem

Beginning on a new page, this section is to present the problem and/or issue that is addressed. The problem and/or issue should be succinctly described, generally in no more than one or two pages. Include a discussion of the context for the problem or issue: Why is it a problem? What are its implications if not resolved? The Nature of the Problem heading should be a Level 0: Centered, boldface, and all uppercase.

Literature review. Included as a sub-section within the Nature of the Problem section, the literature review section is an overview of current and pertinent literature on the topic and is vital to the report. The literature review should be comprehensive enough to demonstrate familiarity with the background and research findings relevant to the project, and to serve as the
basis for establishing a convincing need for pursuing the report. The review may include all or some of the following aspects:

- A review, which is synthesis/summary, of the current and pertinent research directly related to the problem and/or issue;

- A review of what others have done to resolve the problem, directly and indirectly, which will inform and support what is proposed;

- A synthesis of compelling evidence for what is proposed to do.

In scholarly writing, certain types of periodicals and journals are suspect to their credibility and viability as research. Consequently, do NOT cite articles from magazines such as *Ladies’ Home Journal, Time, Sports Illustrated*, etc., unless illustrating the universal nature of the issue. In addition, items which are found using ERIC that are included in the microfiche section of the library are also suspect. ERIC accepts any submission for inclusion; they do not review for authenticity or accuracy. In some cases, research articles not accepted for publication may be submitted to ERIC. However, useful documents may also be located in ERIC. This is not to dissuade from using ERIC. It is to encourage using ERIC with a discerning and critical eye. In using research from the internet, such as Wikipedia, the same cautions apply.

The literature review is written in past tense because the research reported has already been done. However, use present tense when describing research or events that are ongoing.

The *Literature Review* subheading should be a Level 1: Centered, boldface, upper and lowercase.

**Summary.** Include a quick review of the literature found and how it relates to the problem that will be researched. The *Summary* subheading should be a Level 1: Centered, boldface, upper and lowercase.
Purpose

Beginning on a new page, in an introductory paragraph to this section, briefly review the problem or issue. Then state the objective(s) of the proposed study and a description of the purpose. The purpose is stated as a general goal. Objectives may be used to subdivide the purpose into meaningful units and may be stated in question format. Objectives might also be stated as intended outcomes of the report and what the hope will be with the results of the report. This section is written in future tense because it reflects what is proposed. Check that the purpose is aligned with the nature of the problem and literature review, as illustrated in Figure 1.

Nature of the Problem

Issue 1    Issue 2    Issue 3    Combinations

Literature Review

Issue 1    Issue 2    Issue 3    Combinations
Supporting details; conclusions from research

Purpose

Purpose of study based on needs found in literature as it relates to Issue 1, Issue 2, Issue 3, and Combinations.

Figure 1. Project proposal pyramid

The Purpose heading should be a Level 0: Centered, boldface, and all uppercase.

Method

Beginning on a new page, in an introductory paragraph to this section, briefly review the objective(s) and purpose of the report and how the report design will align with said purpose. Then identify the major categories of tasks (steps) that will be taken in order to achieve the stated
objective(s). Under each category, provide a detailed description of the tasks. The tasks to be completed should also have their bases of support in the review of the literature. The Method heading should be a Level 0: Centered, boldface, and all uppercase.

**Participants.** The Method section should include a Participants subheading, if applicable, providing a demographic description of the sample population and a description of how the sample population will be selected for participation. The Participants heading should be a Level 1: Centered, boldface, upper and lowercase.

**Instruments.** The Method section should include an Instruments subheading, if applicable, providing a description of the instruments to be used (survey, focus group, etc.), activities, packets, etc., and how they will be developed. The Instruments heading should be a Level 1: Centered, boldface, upper and lowercase.

**Data analysis.** The Method section should include a Data Analysis subheading, describing how the data will be organized and analyzed for the report. Describe all statistical procedures that will be used to answer the research questions. If the data is qualitative, how will the information be analyzed and presented? It may be useful to take each step of the Method section and describe how the data will be handled in this step. If chosen to do this, the Data Analysis section may not need to be added to the proposal. The Data Analysis heading should be a Level 1: Centered, boldface, upper and lowercase.

**References**

Beginning on a new page, list all of the sources cited in the proposal following APA format standards. The References heading should be a Level 0: Centered, boldface, and all uppercase.
DIVISIONS OF THE FINAL THESIS REPORT

The following will provide a summary of the major divisions of the master’s thesis report. Depending on the nature of the report, there may be minor variations, which are acceptable; consult with the graduate committee chairperson. The divisions of the thesis report are arranged in the following order: Copyright Notice, Title Page, Dedication or Acknowledgements, Table of Contents, List of Tables, List of Figures, Abstract, Body of the Report, References, and Appendices.

Title Page

The title page of the report contains the title of the manuscript, the full name of the student/author, the affiliation (Weber State University), and the date of approval. The committee members’ signatures are also on the title page; do NOT use boldface type (see Appendix B as an example). Be sure to check with the graduate committee members to determine how they wish to have their names and titles on this page.

Copyright Notice (optional)

If needed, permission must be obtained in order to use extensive figures, tables, or text from copyrighted sources. Contact with the copyright holder must be made, any fees paid, and letter of permission attached with the manuscript. Use of copyrighted materials without permissions may be regarded as copyright infringement and subject to damages in a suit.

Dedication or Acknowledgements

Beginning on a new page, the Acknowledgements section allows authors to publicly thank or acknowledge persons who have particularly supported the completion of the thesis; however, it is optional. Keep it one page or less. The Acknowledgements subheading should be Level 1: Centered, boldface, upper and lowercase.
Table of Contents

Beginning on a new page, the table of contents contains all major headings and sub-level headings in the report. However, preliminary pages (Acknowledgements, Abstract, List of Tables, and List of Figures) are not listed in the table of contents. Make sure the headings and subheadings are upper and lower case, regular font or italics. Note that the tab sets for Level 0 headings are at the left margin; Level 1 headings are 0.5” from the left margin; Level 2 headings are 1 inch from the left margin; level three are 1.5 inches from the left margin, and so on.

Set the decimal tab stop so that page numbers will be flush right and that periods will follow the headings or subheadings to the page numbers. This can be done using Microsoft Word by the following process:

1. On the Home tab, in the Paragraph menu, click Tabs (or click the small icon in the bottom right-hand corner in the Paragraph menu, then click Tabs).
2. Under Tab stop position, type 5.99”, or select an existing tab stop to add leader characters (leader characters: A solid, dotted, or dashed line that is used in the table of contents and fills the space use by the tab character).
3. Under Alignment, select the Right alignment for text typed at the tab stop.
4. Under Leader, click the leader option wanted (most common is option 2 – dotted line), and then click Set, then OK.

Make sure everything is double spaced! The Table of Contents heading should be a Level 1: Centered, boldface, upper and lowercase.

List of Tables

Beginning on a new page, type the table titles exactly as they appear in the text. Use decimal tab stops as described in the Table of Contents section (see above). In designing and
developing tables, remember that the table should be self-explanatory and stand on its own if a written narrative were not available. Each table should be listed in numerical order (Table 1, Table 2, etc.), and the order they appear in the body of the report. The title of the table should be italicized in the List of Tables section, and should have a hanging indent, if continuing to a second line. The List of Tables heading should be a Level 1: Centered, boldface, upper and lowercase.

**List of Figures**

Beginning on a new page, type the captions of the figures exactly as they appear in the text. Use decimal tab stops as described I the Table of Contents section (see p. 19).

As with developing tables, figures should be self-explanatory and stand by themselves with a narrative needed. Be sure to label each item appropriately and descriptively, and label each aspect of the figure so that the reader can properly and appropriately interpret the graph.

With graphs, there are appropriate types to use for different situations and purposes:

- **Line graphs** are useful in showing trends over time and between two or more factors.
- **Bar graphs** are effective comparing magnitude and size.
- **Pie graphs (or circle graphs)** are helpful in showing the relationship between the whole and its parts.

Although the title of the figure is not italicized, like the title of a table is, the word *figure* and *figure number* are, with a period at the end (for example, *Figure 1.*, *Figure 2.*, etc.). The title of the figure should also have a hanging indent. The List of Figures heading should be a Level 1: Centered, boldface, upper and lowercase.
Abstract

Write a summary highlighting the key points of the thesis report. The abstract should be between 150 and 250 words, including the topic of the research, research questions, method, results, and conclusions. The abstract should be a single paragraph, double-spaced, and the first line should not be indented. Also, include a minimum of three keywords at the bottom of the abstract that will assist future researchers in finding the thesis report in databases, for example, Weber State University’s Stewart Library (see p. 8 as a sample). The Abstract heading should be a Level 1: Centered, boldface, upper and lowercase.

Body of the Thesis

There are several important differences between the thesis proposal and the final thesis report that should be noted. Each serves a different function and purpose in the completion of the report.

In the final thesis report, the same headings used in the proposal will also be used, with the exception of Data Analysis, this section will be removed since the data will have been collected and interpreted in the Results and Discussion sections. The Purpose and Method sections should also be reworded to reflect past tense. The report is now an account of what happened, the results, an analysis of the results, conclusion, and recommendations. Generally, the project report will include information organized under the following headings: Nature of the Problem, Purpose, Method, Results, Discussion of Results, References, and Appendices.

Nature of the Problem

This section was already written for the proposal and should not require much change, if any. This major section should also contain the Literature Review and Summary of the findings. The Nature of the Problem heading should be a Level 0: Centered, boldface, and all uppercase;
the Literature Review and Summary subheadings should be a Level 1: Centered, boldface, upper and lowercase.

**Purpose**

Beginning on a new page, this section should already be written from the proposal (see p. 16). For the final thesis, however, change the language of the text from future tense to past tense (for example, “This will be researched” to “This was researched”). There may also be additional information added. The Purpose heading should be a Level 0: Centered, boldface, and all uppercase.

**Method**

Beginning on a new page, modify what was written for the proposal (see p. 16) using past tense rather than future tense, just as completed with the Purpose section. Be sure to include a timeline of completions. The tasks completed should also have their bases of support in the review of literature. Also, maintain and update subheadings for Participants and Instruments. The Method heading should be a Level 0: Centered, boldface, and all uppercase; Participants and Instruments headings should be a Level 1: Centered, boldface, upper and lowercase.

**Results**

Beginning on a new page, this section is the heart of the thesis report. This section generally begins with a restatement of the problem and proposed solution. Make sure to give a concise, but detailed, reporting of the results. This section needs to be substantively, definitively, and objectively written. It is a mere recounting of what was found as a result of the implementation of the proposed solution. If a survey was conducted, which included open-ended questions, be sure to do an analysis of the responses and report them. The Method heading should be a Level 0: Centered, boldface, and all uppercase.
Discussion

Beginning on a new page, the discussion takes place within the context of the findings. It is an interpretation and analysis of the results. What do they mean? How does the project resolve the problem or issue it was designed to remedy? What implications do the results have for practice and/or theory?

The Discussion heading should be a Level 0: Centered, boldface, and all uppercase.

Recommendations. Ultimately, the results and recommendations should respond to the need, issue, or problem initially raised. Did the proposed solution resolve the problem? How? Why? Why not? And if not, what should be done next time to better understand and resolve the problem? What more should be studied? The Recommendations heading should be a Level 1: Centered, boldface, upper and lowercase.

References

Beginning on a new page, list all of the sources cited in the paper using the APA format. This section should contain only those materials actually cited in the body of the text. A Bibliography contains materials relevant to the subject but not necessarily cited in the text. For the purpose of the thesis report, use the heading of References.

All references are listed in alphabetical order by the first author’s last name. If there is more than one work by the same author cited, list the references in chronological order (earliest to latest).

References are written with a hanging indent and should be double spaced. The first line of the citation is flushed left and succeeding lines are indented. The References heading should be a Level 0: Centered, boldface, and all uppercase.
Appendices

Place items that really do not fit in the body of the text in appendices, for example, letters sent, forms, survey instruments, etc. Be sure to identify each appendix with a title (see pp. 26-30 as an example). Do not forget to refer to them in the body of the text. Appendices need to be listed in the order discussed in the body of the text. The Appendices heading should be a Level 0: Centered, boldface, and all uppercase.
REFERENCES

Angeli, E., Wagner, J., Lawrick, E., Moore, K., Anderson, M., Soderlund, L., & Brizee, A.


APPENDICES

If there is only one appendix and no other designation is necessary, type APPENDIX as a major heading with a title beneath it. If there are multiple appendices, then each appendix has a letter designation, for example Appendix A and a title beneath it. The format of the appendices does not have to follow the same strict guidelines as the document. It may be single-spaced or use a different font and size. If multiple appendices are used, prepare a page titled Appendices (as above) followed by a list of the appendices as shown below. The Appendices heading should be a Level 0: Centered, boldface, and all uppercase. The use of divider pages between appendices is up to the researcher. The following samples are included in appendices for this manual:

Appendix A: Sample of Proposal Title Page

Appendix B: Sample of Thesis Report Title Page
Appendix A

Sample of Proposal Title Page
THIS REPRESENTS THE TITLE OF THE MASTER'S THESIS PROPOSAL

DOUBLE SPACE BETWEEN MULTIPLE LINES OF THE TITLE

TYPE IN INVERTED PYRAMID FORM

by

Full Name of Student

A proposal submitted in partial fulfillment
of the requirements for the degree
of

MASTER OF SCIENCE
IN RADIOLOGIC SCIENCES

WEBER STATE UNIVERSITY
Ogden, Utah

Month Date, Year

Approved

(Name of Committee Chair & Title)
Committee Chairperson

(Name of Committee Member & Title)
Committee Member

(Name of Committee Member & Title)
Committee Member
Appendix B

Sample of Thesis Report Title Page
THIS REPRESENTS THE TITLE OF THE MASTER'S THESIS REPORT
DOUBLE SPACED BETWEEN MULTIPLE LINES OF THE
TITLE AND IN INVERTED PYRAMID FORM

by

Full Name of Student

A thesis submitted in partial fulfillment
of the requirements for the degree
of

MASTER OF SCIENCE
IN RADIOLOGIC SCIENCES

WEBER STATE UNIVERSITY
Ogden, Utah

Month Date, Year

Approved

______________________________
(Name of Committee Chair & Title)
Committee Chairperson

______________________________
(Name of Committee Member & Title)
Committee Member

______________________________
(Name of Committee Member & Title)
Committee Member